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Chapter 1: Introduction
Space is an AAX format convolution reverb plug-

in that is available in DSP, Native, and AudioSuite

formats. Space was designed to be the ultimate re-

verb for music and post-production applications.

By combining the sampled acoustics of real reverb

spaces with advanced DSP algorithms, Space of-

fers stunning realism with full control of reverb pa-

rameters in mono, stereo, and surround formats.

Space supports 44.1 kHz, 48 kHz, 88.2 kHz, and

96 kHz sample rates.

Space works with mono, stereo, and mono-to-ste-

reo formats. With Pro Tools HD, Space also sup-

ports Quad, 5.0, mono-to-Quad, stereo-to-Quad,

mono-to-5.0, and stereo-to-5.0 multichannel for-

mats.

This guide provides information on installing

and using the Avid Space plug-in for Pro Tools

sessions.

For general information on using plug-ins with

Pro Tools, see the Pro Tools Reference Guide.

Greater-than-stereo formats are only avail-
able with Pro Tools HD.
Space Features

Reverb Features
• Mono, Stereo, Quad, and 5.0–channel output

support

• Multiband EQ

• Independent wet/dry and decay levels

• Separate reverb early and late levels and length

• Control of early size, low-cut, and balance

• Pre delay and late delay controls

• Precise control of low, mid, and high decay

crossover

• Adjustable waveform reverse, displayed in beats

per minute

• Waveform processing bypass

Interface Features
• Full waveform view, zoom, and channel high-

light functions

• On-screen input and output metering with clip

indicators

• Impulse response information display
Chapter 1: Introduction 1
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Impulse Response (IR) Loading 
and Organization Features
• Scrollable IR browser makes finding impulse

responses easy

• Browser supports user-defined IR groups on any

local drives

• Browser keyboard shortcuts

• IR favorites function

• Automatically recognizes common IR formats

for one click loading

• Quick browser buttons allow rapid IR loading

and preview

Automation and Ease of Use 
Features
• Snapshot mode supports rapid changes between

ten predefined reverb scenes

• Picture preview mode allows you to view image

files stored with impulse responses

• Impulse responses stored directly in Pro Tools

presets and sessions for easy session sharing

• New impulse responses can be copied to system

and loaded without closing Space

• iLok support for quick and easy relocation to

other Pro Tools systems

Surround and Post-Production Features

• Full input and output surround metering on

screen at all times

• Separate front, center, and rear levels

• Independent front and rear decay

• Snapshot mode ideal for post automation

requirements

• Seamless snapshot switching

• Automatic phantom channel creation
Space Plug-in Guide
IR Library

• A wide variety of both real and synthetic reverb

spaces and effects

• Mono, stereo, and surround formats

• All reverb impulse responses stored in WAV file

format

System Requirements and 
Compatibility
To use Space you need the following:

• An iLok USB Smart Key

• An iLok.com account for managing iLok

licenses

• A qualified Pro Tools system (version 11.1 or

higher)

Avid can only assure compatibility and provide

support for hardware and software it has tested and

approved.

For complete system requirements and a list of

qualified computers, operating systems, hard

drives, and third-party devices, visit:

www.avid.com/compatibility



Registering Plug-Ins
Your plug-in purchase is automatically registered

when you activate your iLok license (see “Autho-

rizing Plug-Ins” on page 5).

Registered users are eligible to receive software

update and upgrade notices.

For information on technical support, visit

www.avid.com.

Working with Plug-Ins
Besides the information provided in this guide,

refer to the Pro Tools Reference Guide for general

information on working with plug-ins, including:

• Inserting plug-ins on tracks

• Using clip indicators

• Navigating the Plug-In window

• Adjusting plug-in controls

• Automating plug-ins

• Using plug-in presets
Conventions Used in This 
Guide
Pro Tools guides use the following conventions to

indicate menu choices and key commands:
:

The names of Commands, Options, and Settings

that appear on-screen are in a different font.

The following symbols are used to highlight

important information:

Convention Action

File > Save Choose Save from the

File menu

Control+N Hold down the Control key

and press the N key

Control-click Hold down the Control key

and click the mouse button

Right-click Click with the right

mouse button

User Tips are helpful hints for getting the
most from your Pro Tools system.

Important Notices include information that
could affect your Pro Tools session data or
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or mouse
shortcuts.

Cross References point to related sections in
this guide and other Pro Tools guides.
Chapter 1: Introduction 3
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About www.avid.com
The Avid website (www.avid.com) is your best

online source for information to help you get the

most out of your Pro Tools system. The following

are just a few of the services and features available.

Product Registration Register your purchase

online.

Support and Downloads Contact Avid Customer

Success (technical support); download software

updates and the latest online manuals; browse the

Compatibility documents for system requirements;

search the online Knowledge Base or join the

worldwide Pro Tools community on the User

Conference.

Training and Education Study on your own using

courses available online or find out how you can

learn in a classroom setting at a certified Pro Tools

training center.

Products and Developers Learn about Avid prod-

ucts; download demo software or learn about our

Development Partners and their plug-ins, applica-

tions, and hardware.

News and Events Get the latest news from Avid or

sign up for a Pro Tools demo.
Space Plug-in Guide



Chapter 2: Installation and Authorization
Installing Plug-Ins for 
Pro Tools
The installer for your plug-in can be downloaded

from the Avid Store (shop.avid.com) or through

your my.avid.com account. Plug-Ins can also be

purchased retail, in which case the included activa-

tion card provides the necessary information for

downloading, installing, and authorizing your

plug-in (www.avid.com/activation).

To install a plug-in:

1 Download the installer for your computer plat-

form from www.avid.com. After downloading,

make sure the installer is uncompressed (.dmg

on Mac or .ZIP on Windows).

2 If Pro Tools is running, quit Pro Tools.

3 Locate and double-click the plug-in installer

application.

4 Follow the on-screen instructions to complete

the installation.

5 When installation is complete, click Quit (Mac)

or Finish (Windows).

When you launch Pro Tools, you are prompted to

authorize your new plug-in.

For more information about Avid audio
plug-ins, visit www.avid.com/plugins.
Authorizing Plug-Ins
Avid Pro Tools plug-ins are authorized using the

iLok USB Smart Key (iLok), manufactured by

PACE Anti-Piracy.

An iLok can hold hundreds of licenses for all of

your iLok-enabled software. Once a license for a

given piece of software is placed on an iLok, you

can use the iLok to authorize that software on any

computer.

Once you have purchased your software from the

Avid Store or entered your activation code online,

an authorization license for your software is posted

to your iLok account. Authorize your software by

downloading the license from iLok account to your

iLok USB Smart Key.

iLok USB Smart Key

An iLok USB Smart Key is not supplied with
plug-ins or software options. You can use the
iLok included with certain Pro Tools systems
or purchase one separately.

For more information, visit the iLok website
(www.iLok.com).
Chapter 2: Installation and Authorization 5
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To download the license for your software to your

iLok:

1 If you don’t already have an iLok account, visit

www.ilok.com to sign up for one.

2 Log in to your iLok.com account at

www.ilok.com.

3 Follow the online instructions to transfer the

license from your iLok account to your iLok

USB Smart Key.

Removing Plug-Ins
If you need to remove a plug-in from your

Pro Tools system, follow the instructions below

for your computer platform.

Mac OS X

To remove a plug-in:

1 Locate and open the Plug-Ins folder on your

Startup drive (Library/Application Support

/Avid/Audio/Plug-Ins).

2 Do one of the following:

• Drag the plug-in to the Trash and empty the

Trash.

• Drag the plug-in to the Plug-Ins (Unused) folder.

Windows

To remove a plug-in:

1 Choose Start > Control Panel.

2 Click Programs and Features.

3 Select the plug-in from the list of installed ap-

plications.

4 Click Uninstall.

5 Follow the on-screen instructions to remove the

plug-in.
Space Plug-in Guide



Chapter 3: Space

Space is an AAX format convolution reverb plug-in that is available in DSP, Native, and AudioSuite

formats.
Space plug-in
Chapter 3: Space 7
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Space Overview
The following sections provide information on the

concepts of reverb and convolution reverb.

Reverb Basics
Reverberation is an essential aspect of the sound

character of any space in the real world. Every

room has a unique reverb sound, and the qualities

of a reverb can make the difference between an or-

dinary and an outstanding recording. The same re-

verb principles responsible for the sound of a ma-

jestic, soaring symphony in a concert hall also

produce the booming, unintelligible PA system at

a train station. Recordings of audio in the studio

context have traditionally been captured with a

minimum of real reverb, and engineers have

sought to create artificial reverbs to give dry re-

corded material additional dimension and realism.

The first analog reverbs were created using the

‘echo chamber’ method, which consists of a

speaker and microphone pair in a quiet, closed

space with hard surfaces, often a tiled or concrete

room built in the basement of a recording studio.

Chamber reverbs offered a realistic, complex re-

verb sound but provided very little control over the

reverb, as well as requiring a large dedicated room.

Plate reverbs were introduced by EMT in the

1950s. Plate reverbs provide a dense reverb sound

with more control over the reverb characteristics.

Although bulky by modern standards, plate reverb

units did not require the space needed by a cham-

ber reverb. Plate reverbs function by attaching an

electrical transducer to the center of a thin plate of

sheet metal suspended by springs inside a sound-

proof enclosure. An adjustable damping plate al-

lows control of the reverb decay time and piezo-

electric pickups attached to the plate provide the

return reverb signal to the console. An alternative

and less expensive analog reverb system is the

spring reverb, most commonly seen in guitar am-
Space Plug-in Guide
plifiers beginning in the 1960s. Similar to the plate

reverb in operation, the spring reverb uses a trans-

ducer to feed the signal into a coiled steel spring

and create vibrations. These are then captured via a

pickup and fed back into an amplifier.

Since the advent of digital audio technology in the

1980s, artificial reverberation has been created pri-

marily by digital algorithms that crudely mimic the

physics of natural reverb spaces by using multiple

delay lines with feedback. Digital “synthetic” re-

verb units offer a new level of realism and control

unavailable with older analog reverb systems, but

still fall short of the actual reverb created by a real

space.

Components of Reverb

Reverberation sound in a normal space usually has

several components. For example, the sound of a

single hand clap in a large cathedral will have the

following distinct parts. The direct sound of the

hand clap is heard first, as it travels from the hand

directly to the ear which is the shortest path. After

the direct sound, the first component of reverb

heard by a listener is reflected sound from the

walls, floor, and ceiling of the cathedral. The tim-

ing of each reflection will vary on the size of the

room, but they will always arrive after the direct

sound. For example, the reflection from the floor

typically occurs first, followed by the ceiling and

the walls. The initial reflections are known as early
reflections, and are a function of the reflective sur-

faces, the position of the audio source, and the rel-

ative location of the listener.

A small room may have only a fraction of a second

before the early reflections, whereas large spaces

may take much longer. The elapsed time of the

early reflections defines the perceived size of the

room from the point of view of a listener. Space of-

fers various controls over early reflection parame-

ters.



The time delay between the direct sound and the

first reflection is usually known as pre-delay.

Space lets you adjust pre-delay. Increasing the

pre-delay often changes the perceived clarity of

audio such as vocals.

Reflections continue as the audio reaches other

surfaces in a space, and they create more reflec-

tions as the sound waves intermingle with one an-

other, becoming denser and changing in character

depending on the properties of the room. As the

room absorbs the energy of the sound waves, the

reverb gradually dies away. This is known as the

reverb tail and may last anywhere up to a minute in

the very largest of spaces.

The reverb tail will often vary at different frequen-

cies depending on the space. Cavernous spaces of-

ten produce a booming, bassy reverb whereas

other spaces may have reverb tails which taper off

to primarily high frequencies. Space allows for

equalization of the frequencies of the reverb tail in

order to adjust the tonal characteristics of the re-

verb sound.

A reverb tail is often described by the time it takes

for the sound pressure level of the reverb to decay

60 decibels below the direct sound and is known as

RT60. Space lets you adjust the decay as desired.

For surround processing, decay can be adjusted for

individual channel groups.
Space Convolution Reverb
Convolution reverb goes beyond traditional analog

and algorithmic digital reverb techniques to di-

rectly model the reverb response of an actual re-

verb space. First, an impulse response (IR) is taken

of an actual physical space or a traditional reverb

unit. An IR can be captured in mono, stereo, sur-

round, or any combination. The IR, as displayed by

Space, clearly shows the early reflections and the

long decay of the reverb tail.

Space uses a set of mathematical functions to con-

volve an audio signal with the IR, creating a reverb

effect directly modeled on the sampled reverb

space. By using non-reverb impulse responses,

Space expands from reverb applications to a gen-

eral sound design tool useful for many types of au-

dio processing.

The downside of traditional software based convo-

lution reverbs has been the heavy CPU processing

requirement, which can result in convolution re-

verbs with unacceptable latency. Many early soft-

ware convolution reverbs did not offer adequate

control over traditional reverb parameters such as

Pre Delay, EQ, or decay time.

Space redefines reverb processing in Pro Tools by

offering zero and low latency convolution with the

full set of controls provided by traditional syn-

thetic reverbs.

Impulse Response sample
Chapter 3: Space 9
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Space System Design
Space uses advanced DSP algorithms to deliver convolution reverb processing.

The following figure shows the internal system design of Space and demonstrates how Space processes the

audio signal.
Space Plug-in Guide
The impulse computer is an internal module of Space that provides extensive control over the currently

loaded impulse response waveform. When you adjust the parameters shown below, the IR is automatically

recalculated by the impulse computer and reloaded into the convolution processor.

Space internal system design

Audio In

IR Level

Impulse Response

Low and High

Convolution

Processor
Impulse Computer

Shelf EQ

Dry Level

Balance

Wet Level

Out Level

Audio Out



The following figure shows the internal functions of the impulse computer as it processes the waveform

and loads it into the convolution processor.
Space internal functions of the impulse computer

Impulse Response

Width

Front/Rear Delay

Early Length

Early Processing Late Processing

Low
Decay

Mid
Decay

High
Decay

Crossover

Late Delay

Early Size

Early Low Cut

Early Balance

Convolution
Processor

Pre Delay
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Impulse Response (IR) and 
Space
This section covers aspects of impulse response

(IR) and Space.

IR Processing Control Lag
Adjusting some controls in Space requires the im-

pulse computer to recalculate the waveform and

reload it into the convolution processor. This oper-

ation uses DSP and host processing capacity.

When this occurs, some control lag may be experi-

enced. This should be kept in mind if controls are

being automated in real time during a session.

How Impulse Responses Are 
Captured
An IR of an actual physical space is captured using

a combination of an impulse sound source and cap-

ture microphones. The sound source is used to ex-

cite the physical space to create a reverb, and can

be a starter pistol or a frequency tone played

through a speaker. The microphones can be placed

in various configurations. The resulting IR is then

processed to create a digital representation of both

the physical space, potentially colored by the

sound source and the type of microphone used.

Similarly, an IR of a hardware effects unit can be

captured by sending a test pulse through the unit

and capturing the result digitally. In addition to re-

flecting reverb or delay characteristics, an IR also

reflects tonal character and can be used for a vari-

ety of effects beyond pure reverb applications.

Depending on the capture technique used, the IR

may be suitable for use with mono, stereo, sur-

round or a combination of those formats. For ex-

ample, a capture setup with a single sound source

and two microphones is ideal for a mono-to-stereo

IR.
Space Plug-in Guide
Multiple IRs may be taken of a physical space

where the sound source has been moved to differ-

ent physical locations. Each resulting IR may be

used to create individual reverbs for separate in-

struments. This effectively allows an engineer to

place each instrument in the reverb sound field as

if the instruments were physically arranged in the

space.

Space IR Library Installation
You can download IR Libraries from Avid’s Space

Online IR Library. For more information on down-

loading and installing IR Libraries from the Space

Online IR Library, see “Installing Space IR Pack-

ages” on page 21.

Using Third-Party IRs in Space
Space reads a wide range of IR formats automati-

cally, including WAV and AIFF file formats, al-

lowing you to import a variety of IRs. Space sup-

ports IR sample rates from 22 kHz up to 96 kHz in

bit depths from 16 to 32 bits. In addition, Space

supports the display of JPEG format picture files

stored with IRs.

To use third-party IR libraries with Space:

1 In the IR Browser, select Edit > Import Other IR

Folder.

2 Locate and select the library on your hard drive.

3 Click Choose.



Space Multichannel IR Formats
Space supports IRs in multichannel or multiple

mono audio files. IRs with a single input are used

for mono or summed stereo processing and can be

stored as a single interleaved multichannel file, or

as multi-mono files. IRs with stereo inputs used for

true stereo processing must be stored as multi-

mono files.

The following table shows Space IR channel for-

mats.

Input Output
Channel

Order
File Format

Mono Mono — Mono file

Mono Stereo L R One 2-channel

file or two

mono files

Mono Quad L R Ls Rs One 4-channel

file or four

mono files

Mono 5.0 L C R Ls

Rs

One 5-channel

file or five

mono files

Stereo Stereo L R Four mono files

Stereo Quad L R Ls Rs Eight mono

files

Stereo 5.0 L C R Ls

Rs

Ten mono files
For multi-mono files, Space understands the fol-

lowing filename conventions, based on those used

by Pro Tools. The filename format is based on the

impulse name plus two suffixes which indicate in-

put and output channels as follows:

Impulsename.inputchannel.outputchannel.type

• Impulsename is the name of the impulse. Mixing

multiple IR files with the same Impulsename in

the same folder is not supported.

• Inputchannel refers to the number of sources

used for the impulse, starting at the number 1.

An IR captured in true stereo will usually have

two input channels numbered 1 and 2. If there is

only one input channel, then inputchannel is op-

tional and can be omitted. Also, instead of using

numbers 1 and 2, the inputchannel can be desig-

nated as L and R.

• Outputchannel refers to the microphones used to

capture the impulse, and corresponds to your

studio monitors. outputchannel is designated us-

ing the standard L, C, R, Ls and Rs extensions.

• Type is optionally .WAV or AIFF. For best per-

formance, filenames should always be suffixed

with type to avoid Space having to open the file

to determine audio format.
Chapter 3: Space 13
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The following examples show how various multi-

mono IR files could be named.

Stereo to Stereo IR

Cathedral.1.L.wav

Cathedral.1.R.wav

Cathedral.2.L.wav

Cathedral.2.R.wav

Stereo to 5.0 IR

Cathedral.1.L.wav

Cathedral.1.C.wav

Cathedral.1.R.wav

Cathedral.1.Ls.wav

Cathedral.1.Rs.wav

Cathedral.2.L.wav

Cathedral.2.C.wav

Cathedral.2.R.wav

Cathedral.2.Ls.wav

Cathedral.2.Rs.wav

Mono to Quad IR

Cathedral.L.wav

Cathedral.R.wav

Cathedral.Ls.wav

Cathedral.Rs.wav

Stereo to Quad IR

Cathedral.1.L.wav

Cathedral.1.R.wav

Cathedral.1.Ls.wav

Cathedral.1.Rs.wav

Cathedral.2.L.wav

Cathedral.2.R.wav

Cathedral.2.Ls.wav

Cathedral.2.Rs.wav
Space Plug-in Guide
Channel Compatibility and 
Space
Space works best with IRs that match your current

channel configuration. For example, if Space is in-

stantiated in a mono to stereo configuration, stereo

IRs will be highlighted in the IR browser. The IR

information in the display area shows how many

inputs and outputs an IR has. For example, an IR

listed as 2 input 4 output is a stereo to quad IR.

If an IR is loaded that doesn’t match the current

configuration, Space will try to create the best pos-

sible match with the IR provided. For example, if a

stereo IR is loaded into a mono instantiation of

Space, Space will sum the left and right channels in

order to mimic a stereo reverb with both channels

panned to mono.

If an IR is loaded that is missing a required chan-

nel, Space will automatically create a phantom

channel for the IR if needed. For example, if a ste-

reo IR is loaded into a quad instantiation, Space

will compute left and right surround channels au-

tomatically based on the existing channels. If a

quad IR is loaded into a 5.0 channel instantiation,

Space will compute a phantom center from the

front left and right channels. Phantom channels are

indicated by comparing the IR information dis-

played in the display area to the number of chan-

nels in use. For example, a 2 input 4 output IR used

with a 5.0 output instantiation of Space will auto-

matically have a phantom center channel created.



Space Presets
Space supports the Pro Tools Plug-In Librarian.

When an IR file is loaded, all controls remain at

their current positions, as the IR file only contains

the audio waveform. By default, presets contain

both the IR waveform and control settings and can

be saved as required so that specific control set-

tings can be retained for future sessions. If you

save presets without embedding the IR waveform,

be sure that you include the IR waveform with the

session when transferring the session between dif-

ferent Pro Tools systems. Note that a Space preset

only includes the currently selected snapshot.

Space Snapshots
In addition to presets, Space lets you manage a

group of settings, called snapshots, that can be

switched quickly using a single, automatable con-

trol. Each snapshot contains a separate IR and set-

tings for all Space controls.

IRs in a snapshot have been pre-processed by the

impulse computer and can be loaded instantly into

the convolution processor. Snapshots are useful,

for example, in post production mixes when the re-

verb is changed for different scenes via automation

as the picture moves from one scene to another.

IR files are audio files only and do not con-
tain information about Space control set-
tings. If you wish to save specific control set-
tings for an IR, you should save them using
the Pro Tools Plug-In Librarian or using the
snapshot facility of Space.
Embedding IRs in Sessions, Presets, and

Snapshots

By default, all IR and snapshot info used by Space

(including up to ten IRs) is saved in the Pro Tools

session file. Likewise, plug-in presets contain a

saved copy of the IR and settings in the currently

selected snapshot. Session and preset file sizes will

increase as Space stores each IR waveform inside

the file. This provides maximum compatibility be-

tween different Pro Tools systems without the

need for them to have identical IR libraries.

IR embedding can be disabled in Space’s Prefer-

ences. If IR embedding is disabled, Space stores

only a reference to the name of the IR file. When

the session is transferred to a different system,

Space attempts to load the matching IR file from

the Space IR library. For maximum compatibility,

ensure that all of the appropriate IR files are avail-

able on the new system.

When working with an IR that only exists in a ses-

sion file, ensure it is saved to a separate snapshot or

preset. If the IR is overwritten by loading a new IR

and the session is saved, the original IR cannot be

recovered without access to the original IR file.

By default, Pro Tools presets or session files
created using Space automatically include
copies of all relevant IR waveforms. This pro-
vides maximum compatibility of session files
between different Pro Tools systems.

It is your responsibility to ensure that you ob-
serve the copyright on any IR transferred to a
third party in this fashion.
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Space Controls and Displays
The Space interface is divided into the following sections:

1 Display area (See “Space Display Area” on page 17.)

2 IR Browser (See “Space IR Browser” on page 20.)

3 Primary controls (See “Space Primary Controls” on page 22.)

4 Group Selectors and Controls (See “Space Group Selectors and Controls” on page 23.)
Space Plug-in Guide
Space interface

1 2

3

4



Space Display Area
The display area of Space operates in the following

four modes, indicated by the Display Mode selec-

tors at the top right hand corner of the Space win-

dow:

• Waveform mode

• Picture Preview mode

• Snapshot mode

• Preferences mode

The Display area changes based on the selected

mode.

Info Bar

At all times, the Info bar at the bottom of the dis-

play area window shows the following controls

and information.

Snapshot Menu A pop-up menu allowing quick

selection or automation of a snapshot.

IR Name Displays the folder and file name of the

currently loaded IR.

Quick Browser Controls The Quick browser con-

trols allow the IR to be quickly changed even when

the IR browser is closed, automatically loading

each IR sequentially. The Waveform icons step

backwards and forwards through IRs and automat-

ically load the IR file. The Folder icons step back-

wards and forwards through folders. The Quick

browser requires an IR to be currently loaded from

Display Mode selectors

Info bar
the IR browser. If no such IR is loaded (for exam-

ple, the IR in use has been loaded from a preset or

session but does not exist in the IR browser), the

Quick browser controls are inoperative.

Space Waveform Mode
Waveform mode is selected using the Waveform

icon at the top of the Space window.

Waveform mode displays the IR waveform along a

horizontal axis marked in seconds and the vertical

axis marked in amplitude. The early section of the

waveform is highlighted in a lighter color. In addi-

tion, the channel selector highlights the current

channel in the waveform.

IR information such as sample rate and number of

input and output channels is displayed at the bot-

tom right of the waveform.

The controls in Waveform mode function as fol-

lows:

Original Bypasses all waveform processing, al-

lowing the original IR to be auditioned. This con-

trol effectively bypasses the processing in the IR

computer as shown in the system diagram.

Display area, Waveform mode
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Channel Selectors Displays from one to five

channels (in the order Left, Center, Right, Left

Surround, Right Surround). Click the desired

channel to display the IR waveform for that chan-

nel. In Mono mode, no channel selector is dis-

played.

Zoom Zooms in and out on the time axis for the

waveform display.

Space Picture Preview Mode
Picture Preview mode is selected using the Picture

Preview icon at the top of the Space window.

When selected, Picture Preview mode shows pic-

tures associated with the IR. For an IR provided

with Space, this will usually include a photograph

of the location, and an image with technical details

such as microphones used or an overview of the

microphone setup. Thumbnails of images are dis-

played in the right hand column. In this mode, the

IR browser can be used to view the associated pic-

tures without loading the IR itself.

Space Snapshot Mode
Snapshot mode is selected using the Snapshot icon

at the top of the Space window. Space provides up

to ten snapshots that are available at all times. Each

snapshot stores a separate IR waveform and all

control settings. Snapshots are optimized for quick

loading into the convolution processor, and

Display area, Picture Preview mode
Space Plug-in Guide
switching between snapshots is considerably faster

than loading a new IR. Snapshot mode allows all

ten snapshots to be viewed as well as the option to

select, rename, copy, paste, and clear snapshots.

The name of the currently selected snapshot is al-

ways displayed in the Info bar at the bottom of the

display area, and can be automated. This lets you

switch reverb settings during playback and is use-

ful for post production sessions where the reverb

setting may change as the scene changes.

The active snapshot can be selected in one of two

ways. At any time, a snapshot can be selected by

using the snapshot menu in the Info bar. Alterna-

tively, when the display area is in Snapshot mode,

a snapshot can be selected by clicking the selection

area next to the snapshot name.

Select Lets you select which snapshot is currently

loaded.

Name Displays the name of each snapshot. By de-

fault, snapshots are named “Snapshot 1” through

“Snapshot 10.” Snapshots can be renamed by

clicking on the snapshot name and entering a new

name followed by the Enter key (Windows) or the

Return key (Macintosh).

Sample Path Displays the name of the IR selected

for each snapshot.

Copy Copies the currently selected snapshot set-

tings into a clipboard.

Display area, Snapshot mode



Paste Pastes the clipboard into the currently se-

lected snapshot. Note that the name of the existing

snapshot is not changed by pasting a new snapshot,

in order to avoid duplicate snapshot names.

Clear Clears the IR from the currently selected

snapshot.

Space Preferences Mode
Preferences mode is selected using the Preferences

icon at the top of the Space window. This displays

a number of preferences settings for Space.

Embed IRs in Preset & Session Files Enables or

disables the embedding of IR waveforms in presets

and session file. By default, this is enabled.

Installed IR Packages Displays a list of installed

Space IR packages and their versions.

Display area, Preferences mode
Space Meters
The Meters display the amplitude of the incoming

and outgoing audio signals by channel. The num-

ber of meters shown will depend on the number of

input and output channels. Input meters may be

mono or stereo, and output meters may be mono,

stereo, quad, or 5.0 channels. Each meter is marked

as either mono, left, right, center, left surround, or

right surround. A logarithmic scale marked in

decibels and momentary peaks are also displayed

on the meter.

The red Clip indicators at the top of the meters in-

dicate clipping on the corresponding channel.

When a channel has clipped once, the clip indica-

tor remains lit and additional clips will be shown

by a variation in the color of the indicator. The clip

indicator for all channels can be cleared by click-

ing on any clip indicator, or selecting Track > Clear

All Clip Indicators in Pro Tools, or pressing Op-

tion+C (Mac) or Alt+C (Windows).

Meters, stereo input to 5.0 output shown
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Space IR Browser
The IR browser lets you quickly and easily install,

locate, and organize IRs on local hard drives. The

Load and Edit buttons in the IR browser let you in-

stall and import IRs, create Favorites, and change

the IR groups displayed.

Space automatically highlights each IR that

matches the current channel configuration. For ex-

ample, when using a Space Stereo to Quad insert,

each IR with that configuration is highlighted. Im-

pulses that are not highlighted can still be loaded,

and Space tries to adapt the IR to the current chan-

nel format (see “Channel Compatibility and

Space” on page 14).

An IR can be loaded by double clicking with the

mouse, or using the Load button displayed at the

top of the IR browser drawer. The currently loaded

IR is highlighted with a small dot next to the file

name in the browser.

IR Browser
Space Plug-in Guide
The IR browser can be operated using the follow-

ing shortcuts. When the IR browser has keyboard

focus, a blue highlight is displayed around the edge

of the browser window.

The IR browser lets you install and import new

IRs. Each IR folder reflects a folder on the hard

drive. When importing a new IR folder, a standard

file dialog will be displayed to enable the user to

choose the folder that contains the desired IR.

The IR browser also provides a Favorites folder,

which is a user defined group of links to IRs in the

IR browser. Favorites can be sorted in any desired

order by dragging and dropping them as required.

In addition, folders can be created in Favorites us-

ing the ‘New Folder in Favorites’ function in the

Edit menu.

To add an IR file or folder to the Favorites folder:

1 In the IR browser, select the desired IR file or

folder.

2 From the IR browser’s Edit menu, select Add to

Favorites.

IR Browser Shortcuts

Browser

Navigation

Arrow Keys

Load IR Enter (Windows)

Return (Mac)

Open/close

all folders

Alt-click (Windows)

Option-click (Mac)

Edit menu Right-click (Windows or Mac)

Control-click (Mac)

Return key-

board focus

to Pro Tools

Escape key



Space IR Browser Edit Menu
The IR browser’s Edit menu contains the follow-

ing commands:

Download Space IR Package Opens a Web

browser to the Space online IR library.

Install Space IR Package Installs a new IR pack-

age downloaded from the Space online library (see

“Installing Space IR Packages” on page 21).

Import Other IR Folder Lets you import a new IR

folder in common file formats. By default, the new

IR is given the same name as the selected folder.

Remove Imported IR Folder Lets you remove the

currently selected IR folder.

Rename Imported IR Folder Lets you rename the

currently selected IR folder.

Add to Favorites Adds the currently selected IR to

the Favorites group at the top of the browser win-

dow.

New Folder in Favorites Creates a folder in the

Favorites group. Favorite IRs can be dragged and

dropped into the folder.

Rename Favorites Folder Lets you rename the

currently selected Favorites folder.

Remove from Favorites Removes the currently

selected IR from the Favorites group. This func-

tion only removes the link in the Favorites group

and does not remove the original IR file from the

system.

Reset to Default IR Library Resets Space to the

default library. This also removes any user im-

ported IR folder, but does not affect the Favorites

folder, or IR packages installed from the Space on-

line IR library.
Rescan for Files Forces Space to check the hard

drive for new IRs. This is typically required if new

IR files have been copied to the hard drive. Using

the Rescan for Files command loads new IRs into

Space without needing to close Space or the

Pro Tools session.

Installing Space IR Packages 
Additional IR packages for Space are available for

registered users to download from the Space On-

line IR Library at:

www.avid.com/tlspace/impulselibrary/

These package files are supplied in a lossless com-

pressed format.

To install a Space IR package:

1 In the Space IR browser, select Download IR

Package from the Edit menu. Your default Web

browser launches and loads the Avid Space On-

line IR Library website.

2 Click Download

3 Log in using your email address and password.

You may need to create a new account if you

have not yet registered Space.

4 Click Continue.

5 Click Download for the IR package you want.

6 In Space, select Install Space IR Package from

the Edit menu.

Space may pause briefly while it scans the
hard drives to locate IRs or if all folders are
opened at once. The amount of time taken is
proportional to the number of folders and IRs
scanned.

To download IR packages from the Space
Online IR Library, you must first register
with Avid and create an online profile.
Chapter 3: Space 21
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7 In the resulting dialog, locate and select the file

you downloaded.

8 Click Choose.

9 Click Install to install the IR package.A window

is displayed with the results of the installation.

The IR browser in Space updates to include the

new IR.

If a problem occurs with the IR installation, Space

displays an error message. Review the log file

stored in the Space IR library for further details.

Each IR package has a version number, and Space

warns you if an IR package has already been in-

stalled.

The details of all installed IR packages can be re-

viewed using the Show Packages option in Prefer-

ences mode.
Space Plug-in Guide
Space Primary Controls
The primary control group is visible at all times

and allows control of key reverb parameters. This

includes the wet and dry levels of the audio passing

through Space.

Reset Resets all Space parameters except Wet,

Dry, and Input and Output Level.

Wet Controls the level of wet or effected reverb

signal, from –inf dB to +12 dB.

Dry Controls the level of dry or unaffected reverb

signal, from –inf dB to +12 dB.

Decay Controls the overall decay of the IR wave-

form and is displayed as a percentage of the origi-

nal. When Decay is adjusted, the waveform is re-

calculated in real time.

Space primary controls



Space Group Selectors and 
Controls
Space presents reverb controls in five different

groups. Each group is activated by selecting the

corresponding selector.

Space Level Controls
The Levels group provides control of the overall

input and output of the reverb, including individual

controls for early and late reflections, and indepen-

dent front, rear, and center levels for surround out-

puts.

Input Cuts or boosts the input signal level from

–inf dB to +12 dB.

Output Cuts or boosts the output signal level from

–inf dB to +12 dB.

Early Cuts or boosts the levels of the early reflec-

tions from –inf dB to +12 dB.

Late Cuts or boosts the levels of the late reflections

from –inf dB to +12 dB.

Group Selectors

Level controls (5.0 shown)
Front/Rear/Center In quad and 5.0 channel output

modes, Space provides additional controls to atten-

uate or boost the Front (left and right), Rear (left

and right), and Center (5.0 only) signal levels from

–inf dB to +12 dB. In 5.0 output mode, the level of

the center channel is affected by both the Front and

Center controls.

Space Delay Controls
The Delays group provides controls for the delay

timings of the reverb. When changes are made to

any control in the Delays group, the IR waveform

is recalculated and displayed in the Waveform dis-

play.

Pre Delay Adjusts length of the Pre Delay from

–200 to +200 ms. The Pre Delay is the time be-

tween the direct sound and the first reflection. In-

creasing the Pre Delay often changes the perceived

clarity of audio such as vocals. Pre Delay adjusts

the delay of the overall impulse and affects both

the Early and Late portions of the IR equally.

Pre Delay can be set to negative values to allow for

subtle or radical changes to the reverb. For exam-

ple, a small negative Pre Delay setting can be used

to eliminate the early portion of an IR. A large neg-

ative Pre Delay setting lets you use the very end of

a reverb tail for creative sounds not possible with

standard reverbs.

Delay controls (5.0 shown)
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Late Delay Adjusts length of the Late Delay from

zero to +200 ms. The Late Delay is the time be-

tween the Early Reflections and the Late Reflec-

tions or tail of the reverb.

Increasing the Late Delay control from zero allows

the reverb tail to be delayed so that it does not start

immediately after the early portion of the IR. As

Late Delay is increased, the reverb tail starts later

in time and makes the reverb space sound larger.

Large amounts of late delay can be used to achieve

creative effects not possible with standard reverbs.

Front/Rear/Center Delay In quad and 5.0 channel

output modes, adjusts length of the Front, Rear,

and Center Delays independently from zero to

+200 ms.

Space Early Section Controls
The Early group controls the character of the early

portion of the IR and the early reflections. The pri-

mary control is Early Length which defines the

size of the early portion of the IR waveform. When

loading an IR from an audio file, Space relies on

the user to define which part of the IR is the early

portion of the waveform. By default, the Early

length is set to 20 ms.

Early controls
Space Plug-in Guide
The early portion of the IR waveform is high-

lighted in the Waveform display. If Early length is

set to zero, then the Early setting have no effect on

the audio. Otherwise, when changes are made to

any control in the Early group, the IR waveform is

recalculated and displayed in the Waveform dis-

play.

Length Adjusts the length of the Early reflections

from zero to 500 ms. When set to zero, other con-

trols in the Early group have no effect on the audio.

The Early Length control adjusts the point in the

impulse where the early portion ends and the late

portion or tail begins.

For the most realistic reverb results, Early Length

should be adjusted while viewing the waveform

display. The early portion of a reverb IR is typi-

cally seen as a series of discrete spikes at the begin-

ning of the waveform. Early Length can however

be adjusted to any value to explore other creative

possibilities.

Early controls indicated in IR waveform



Size Changes the size of the Early reflections,

from 50% to 200%. Early Size expands or con-

tracts the reflections in the early portion of the IR

(as specified by the Early Length control). Reduce

the Early Size to give the space a smaller, tighter

sound. Increase the Early Size to give the space a

larger, roomier sound.

Lo Cut Early Lo Cut controls the frequency of a

highpass filter applied to the early portion of the IR

(as specified by the Early Length control). The de-

fault setting of zero disables the highpass filter. As

the control is set to a higher value, the corner fre-

quency of the highpass filter is increased. Use this

control to reduce boom and low frequency cancel-

lations that can happen when mixing the reverb

output with a dry signal.

Balance Early Balance controls the left/right gain

balance of the early portion of the IR (as specified

by the Early Length control). Adjust the Balance to

control the apparent position of the reverb input in

the stereo image. A negative value reduces the

right channel gain. A positive value reduces the

left channel gain.

When loading an IR from an audio file, Space
relies on the user to define which part of the
IR is the early portion of the waveform. If the
Early Length is set to zero, controls in the
Early group will not affect the IR.
Space Reverb Section Controls
The Reverb group offers a low and high shelf EQ

in addition to width and balance controls. The EQ

operates prior to convolution processing.

Lo Freq Adjusts the frequency of a low frequency

filter from 20 to 500 Hz.

Lo Gain Cuts or boosts the frequency set in Lo

Freq from –15 dB to +15 dB.

Hi Freq Adjusts the frequency of a high frequency

filter from 500 Hz to 20 kHz.

Hi Gain Cuts or boosts the frequency set in Hi Freq

from –15 dB to +15 dB.

Width Increase or reduces the stereo spaciousness

of the reverb. Use this control to tailor the reverb’s

character in a mix. Keep in mind that an IR that has

little stereo separation to begin with may have lim-

ited results.

Balance Controls the balance of the reverb output.

Use this control to balance a reverb from an IR that

has been captured without a centered stereo image,

or for creatively controlling the character of the re-

verb in a mix.

Reverse Reverses the IR waveform and controls

the total length. As the IR waveform is recalcu-

lated, it is re-displayed in the Waveform display.

The value shown is measured in Beats Per Minute

to let you easily match the tempo of the music.

Reverb controls
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Space Decay Section Controls
The Decay group controls allow the user to control

the decay of the low, mid, and high frequency por-

tions of the IR. Use the controls to tailor the re-

verb’s character for a mix or for creative possibili-

ties not found in traditional reverb processors.

Low Decreases or increases the rate at which low

frequencies decay.

Low Xover Adjusts the frequency point that di-

vides the IR into low and mid frequency portions.

Mid Decreases or increases the rate at which mid

frequencies decay.

High Xover Adjusts the frequency point that di-

vides the IR into mid and high frequency portions.

High Decreases or increases the rate at which high

frequencies decay.

Front/Rear In quad and 5.0 channel output modes,

Front and Rear independently control the decay for

front and rear channels.

If the waveform is reversed using the Reverse
control, effected audio may continue to play
for several seconds after the transport is
stopped or audio input finishes.

Decay controls
Space Plug-in Guide
Using Space
This section addresses some common scenarios in

which Space can be used during a Pro Tools ses-

sion.

Using Space Presets
Space comes with a selection of factory presets for

different reverb sounds. The presets are designed

to give a sample of the various IRs available from

the Plug-In Presets selector in conjunction with

various reverb settings. However, the presets do

not cover the entire IR library.

Using Space on an Effect Send
When Space is used on an Aux Input track as an ef-

fects send, the Dry control should be set to –inf dB.

Automating Space Snapshots
Snapshot automation is a powerful method of

changing the reverb parameters without having to

individually automate each parameter.

To automate Space Snapshots:

1 Insert Space on a track.

2 Select Snapshot mode.

3 Load an IR into each Snapshot and make any

desired changes to specific Space controls.

4 Name each Snapshot as desired.

5 Click Auto.

6 Add Snapshot to the list of automated controls.

7 Select Space > Snapshot from the automation

menu for the track.

8 Draw the desired automation on the track with

the Pencil tool. The names displayed in the au-

tomation track will match the names entered for

each Snapshot.



Space IR Library Categories
Space includes an extensive impulse response library, divided into the following categories.
Category Description

Halls Halls and auditoriums

Churches Churches and chapels

Rooms Large and small rooms

Chambers Traditional studio reverb chambers

Plates Classic electromechanical reverb plates

Springs Classic electromechanical reverb springs

Digital Reverbs Classic and contemporary digital reverb units

Post Production Post production impulses

Tiny Spaces Small reverbs from everyday objects

Effects Non-reverb effects for sound design in multiple categories
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